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EEHBERALRE VHBIRPR b Do not climb onto the printer. Non salire sulla stampante.
A CAUTION
Do not drink the liquids under any circumstances, 7 —

as they can cause vomiting and diarrhea.

Take care not to let the liquids come into contact
with your eyes or onto your skin,

otherwise inflammation can result. /J\‘B‘—E'—iﬂl?l
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A ACHTUNG

Bitte trinken Sie nicht die Flussigkeiten,

da die Gefahr von Erbrechen und

Durchfall besteht. Vermeiden Sie den Kontakt
der Flussigkeiten mit Augen und Haut,

sonst kénnen diese gereizt werden. 8
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Ne pas avaler les liquides d'aucune maniére, FHOFOBNMBRNEIBCELIE,

car ceci pourrait entrainer vomissements et diarrhée, AFEE

Veuillez a ne pas laisser ces liquides étre en contact BTSRRI 8 A B R 2
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P : A CAUTION
A ATENCION Do not drink the liquids under any circumstances, as they can cause vomiting and diarrhea.

Take care not to let the liquids come into contact with your eyes or onto your skin,
otherwise inflammation can result. Keep the liquids out of the reach of children.

No tome los liquidos en cualquier caso,

como pueden causar vomitar y diarrea. A ACHTUNG
Tome el cuidado para no permitir que los liquidos Bitte trinken Sie nicht die Flissigkeiten, da die Gefahr von Erbrechen und Durchfall besteht.
toquen los ojos ni en la piel, Vermeide_n Sie de_n Kpnlakt der Flussigkeiten mit Augen und Haut, sonst kénnen diese gereizt werden.
de otro modo inflamacién puede resultar. Halten Sie die Flussigkeiten von Kindern fern.
A ATTENTION
A ATTENZION E Ne pas avaler les liquides d'aucune maniére, car ceci pourrait entrainer vomissements et diarrhée.

Veuillez a ne pas laisser ces liquides étre en contact avec les yeux ou la peau,
car ceci pourrait entrainer une inflammation. Maintenez les liquides hors de portée des enfants.

Non bere per nessun motivo i liquidi poiché

possono causare vomito e diarrea. A ATENCION
Evitare il contatto di questi liquidi con gli occhi e con No tome los liquidos en cualquier caso, como pueden causar vomitar y diarrea.
la pelle poiché potrebbero creare infiammazioni. Tome el cuidado para no permitir que los liquidos toquen los ojos ni en la piel,
de otro modo inflamacién puede resultar. Mantenga los liquidos fuera del alcance de nifios.
A ATTENZIONE

Non bere per nessun motivo i liquidi poiché possono causare vomito e diarrea.
Evitare il contatto di questi liquidi con gli occhi e con la pelle poiché potrebbero creare infiammazioni.
Conservare i liquidi lontano dalla portata dei bambini.
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_ W Deposite in compliance with your local regulations.
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: a|z 2N e B Gebrauchte es gemaB értlichen Richtlinien entsorgen.
Hazardous moving parts. ﬁj‘ jJ E,JA“? nlz,fbl:’ jb@ W Jetez conformément a la reglementation locale en vigueur.
. e W Deseche siguiendo la normativa local.
Keep flngers and IKTZ%EA?E‘ N %”fl’ixf%‘:;ﬁé M Smaltire in conformita alle normative locali.

other body parts away.
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Hazardous voltage will | Hochspannung verletzungsgefahr! |Un voltage non adapte provoque| Un voltaje inadecuado puede
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(6) iHHEETFLEHT . SRGIHEH"GTX-4 Installation" &%+ TENHL.
[5%]
o [HEHITEISLERIMIIGIEIZ )G, Rl GTX-4 Installation” JA%EFTENHL.

SR WY I GTX-4 Maintenance [HI/EN 715
1 | [%E CRIE] — "7-4-1. R E >>P.196"
"7-4-2. E\‘D“Lﬁ‘n%
2 | (EHITEIRIE ] | — T TR

RACHGEYIH T (OHP R 55)

3 | [ S A] "7-4-3. R ] >>P.198"

K
4 | [EAHES R SES "T-4-4. EEEAGES >>P.199"
i e R T B Rt T | 745, % R o
5 | RFFAEMRARALE] il = 5>p 200"
A oI SRR e AR A
B Bt LD T TR AL
Ty o Bk L
1 | [ CR &) AT
(BT BT
" A TESR IR E S s B,
E N Bl YARYA N A
2 | EEATER R RE] SCHAER TR, TR T A, 4
Py
BT EIT
N T TSR B se R, Tk,
3 | [ ) UM TR, TR A, 4
R,
4 | PEBOE T
5 | (MM LE] R
6 | DB A I i ] fry=
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4-3-3. LAN ZE#ER: WEITEIFLRY IP Hubk

VB A

FTEIHL IP b8 B 7324 2 F, M PC A= B iR B BRI T ENH LS B R B . M AT BN LS B A T B
iHZME"8-14. K H IP Hulik >>P.214",
[5%]

™

(2
@)

LAN HEH, 28 deRIGT ETRLIK 1P Hulik.

74k, BEIAIT"4-3-4. LAN JEE: (£ PC FHRHIATEINL >>P.44",

WHI 5 BE .

FEATENHLREYR ONCIRZS R, it USB 2.0 4% PC HIHTENHL.
(%]

o JERZUSB AR, TR EE AT E .

MRS BTG R ik 3" Brother GTX-4 Tools"f#]"GTX-4 Maintenance".
SoRPUNEEE, SROE IP i), AdF—H].

PC thANRBIFTENNLN, ATRERAR D RCIERAI IP Hikt. 1%

Y Brother GTX-4 Maintenance

IR TEMRIEE2ATA « PCATTEM 2 -
TEEFETED -

['a'irtual printer '] [ ik

WM TEARTE. B “F—5" o

_ EIRATEN ERHAIRE
ERTTEN &I EET =,

EEELAE ‘
FETORRERRORBAIL. ERTIIAH AL,
EAEREER e oo

N85, ERORE (R BEHEFAR.

D A ae i ent s
HESCHECHEHEERIHAE.

EREE _ -
ARREE. OHFARFSOER XN

D e EER R T AR R
HEEEEEAF NN NEARE.

D BEHEIET_ RN EReE
ERHEL S EFT RN RRE TS RE.

=1 =T

xifl
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oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

Tk EEA 1P Hibk” it
(5) FINEICHAE ATEDHLINP Hokik]. [FIHERG]. [ERIARORIME, i F—H]. CEEE G
‘;E’ Brather GTX-4 Maintenancs E‘
FAtei:-

TEATENL R R EAIEAL - TR - BRE.

cisofra] wn
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" H SR TP Hhik” i

(5) FEITEIHLFHNIE RN, sl TP,
(%]
o EHAmE AL 31 NFAT.

§ Brother GTX-4 Maintenance =
Step 2:
WAEHE
T A SR BRI
EHE - i)

#T “T—" . SahFEIritte

TF Il wE

(6) BR[O AFTEMHLIERIRE IP Hibk. [JE45H.
NP Hihk, RS BRIARDGES RIS, SNt IR E S B E.
¥ Brother GTX-4 Maintenance u

Step 2:
(=

EAFTEME R SR TP -
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oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

4-3-4. LAN &E#ER: 7E£ PC hRmITENNL

(1) f8H LAN Ze85K: PC AIHTENHL S IZRIERE,  HE@ATENHLA Y.
(%]
o JERZLAN LGN, TR EE AR E -
(2) Mz AR PR AT EIAL o
(%]
e Windows 8.1 i, M[FZfHIIR] i A BLAAETEIL].
e Windows 10 itf, M[BE]FIEHBER]>[BEAMTTEIHI]

(3) A[AIIFTEIHL.

(L) = » =omE » BESE » BEAFION v |42 || == wmammnn 2|
EhnigE I EAHTEI I M @
4 FTENHFAER (4)
Brother GTX-4 Brother GTX-4 Fax Microsoft XPS
Fil=Output Document
Writer
435 4)

NP

DELL E178FP  MSKAIHATSU-P  USE Keybosrd  USE Optical
C Mouse

/ B P
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(4)  WEEERITENH LSRR I B AR IAHA T EIRL]

(%]

Windows 8.1 i, G [E A ZMFTEINLAES IR, [l Fah s B A INAH TENFLE LT ENHL],
Windows 10 i, e[ ZHFTEMHIAMES IR S, EFNEE T EASIAMET EHLE R 2T BT,
p——

o) T I

ETETAZEAETHIIL

& BIAFETEDELL)
TR USE fIEDEERIER, (8, USE FEHLS | Windows £ERE2. )

# BEES, 7oLk Bluetooth FTEDHN)
RECHT SIS | HES Bluetooth STRETEIEER,

(5) EFR[ENE B, MR HEEStandard TCP/P Port], sidi[ F—7].

G = stmiam

TR
FTENMOE et B T B ks,

D FRFREREsRC): LPT1: (FIEe)

Isundmd TCP,‘IP Part

=2 E=N
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oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

(6) FE[EHAEL IP HuhE] A A BCE KT EIHLAY 1P uhik, BOH[EWATENHUIT B Shife 208 HI AT ENHLREhRE FP] i 2
ML, Sl T2 (EmEARED

[N
G = e

HEASTEIMNGEH S 1P ikt
e TCR/TP 13 /]
A2 IP by 192.16E.0.2 I
wOEF(: 192.16E.0.2
IS T S S T )

==

(%]
o EEZFRBUZEITENUG 1P b, FEFSHAAAN 1P k. T LU A RS B AP
HObEH TR . AN AIESIR8-21. MiAR(EIE >>P.218".

o  fIH DNS 55y, FTRURMATHLAAEAZEN IP Hibk. TALEIERMAENL"4-3-3. LAN FEEN: WEFTEIILK IP
Ik >>PA0" B BTN HAAEE ARG BB

(7) 7 TCP /1P i LIS TN [f], ASINES A, E S AASINA S 5 S i .
(8) WoRLANHi G, B e EE X, s E]

3 = Etore

EEEmOEE

FiE HoERREE. ERE

L iEsCITH.

1, FEECEE.

1. EEREEFR.

4, ¥i— EdthbER.

MRE TR . 86 L8 SER LT . SSsiEEi e ETE s
£ SRS TEeT)  BIE T EaaEEEE,

S S Generic Network Card
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(9) EH[YFHILPR], 7E[LPR ¥ EIFIBASZ AR FHHA"BINARY _P1", ri[ffiE].
REIEE G, Sd N5

mormes I
WAERE

wE P 192,168,002
FIEDHLERE 1P kA 192.168.0.2
Bl
FEEs
SN 9100
LPR =D
—
[ BHT LPR=FHIE)
O ST SHMP #358
HESFLC: public
CMMP IS T |1

(10) SEoRLAR g, AR 2]

FEfTHBERHER

/ BFIFFEEITONL. & Windows Updete HIEEESRES.

EELES (0 DEENERS , BT JEsng |
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(11) ASEUYE], R4 PC 1 OS (32bit fix / 64bit fi) 1R 235527 H11"32bit_O0S"5"64bit OS" k.
BRI AR)E,  mfE]

T X
M EASAE , PSR O T T T =
- 0 i B =
T
T ERER €
- =

(12) 1ERAARE SRR QI FSCI R KT ENHUREIRE 7 5113 .
B, s F

O = msan

LHATEDNBRENEF
‘g-’; INFIEFREEITA, 2E Windows Update LIEEEEES,
EE)\2 D [BEMES , Bad Alsnw |,

ETEIH

ElBrother GTX-4

5 HETEFEAEEHSMBEAEE. | Windows Update | | mamszsen. |
" n

E=TN
(13) SR N HEI S, SR EHARTHRsiET], st —2.
—
3 = moEn
PR AR R
Windows KRS FTEINEST— S,
O BESSESSN TR

==
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(14) HNHTENLER, ki1

HLESRE: Brother GTX-4 [LAN)

BFTEOYHE S Brother GTX-4 SRR,

(15) ASAHATEIHL, s PR R IR AL ZX GITHIN, Al T2

Printer Sharing

I you want to share this printer, you must provide a share name. You can use the suggested name or
type a new one. The share name will be visible to other network users.

() Share this printer o that others on your network can find and use it

Share name:

Location: |

Comment:
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(16) MR AT ZHEFFBEENERMSTENL], mii[5Enk]. PC I E BILLAE AT

B A

u@mﬁ

FIEIER(E)

2 E42RENRN Brother GTX-4 (Bl 1)

EERSTOVETERT . SEESSTOVNAEERSES | JIH—SxlER.

FAUE) g

(17) HHBEFHE . RIGIE"GTX-4 Installation" %47 EHL.

(%]

o [HEIITENLEIVILGEHREIZ 5, FIE"GTX4 Installation" 4T EIHL.

HKHA

e

Z8 GTX-4 Maintenance ffEMV 715

1 | [% CR #)F]

"7-4-1. R AEE >>P.196"

2 | [EHATELK G IR E]

"7-4-2. FEHATEKJE IRIAHBIE
>>P.197"

3 | [IRREN I [

RAREGEVIH T (OHP A5
SEL

"7-4-3. VAR (A >>P.198"

4 | USBudE iR

EES

"7-4-4. VAEEEAGHY >>P.199"

5 | FFHEAR G E]

RN I R OSSR E T

il

"7-4-5. 5i5F A R ARIAL
B >>P.200"

[ o 7 5 s

"7-4-6. MG A 1R SR I TR A s

H] # >>P201"
H Ly SRR AR A
At SRR B RS, il "G TX-4 Maintenance"i#H 47 LA R EL.
KL SRERESYNT R SR VN
1 | [A% CR#¥] AT
R EATEN ST

2 | [ESITEI KR RIRIAG BE]

ROFTHELI B E e R, BOH X,
KA TH, FHRRSE TR, 4k
gh b

3 | [T L ]

SO OAT RIS IT
RAOFTEERN R E e, B,
KAYE TR, PRGN TR, 2%
g

4 | [EHEEA IR AT
5 | A GFEORIALE] PN
6 | [ A R S R TR ) 5 ] AT
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VB A

4-4. FTEHLAIFES)

(4%]
o EENTHTENUEHER ]S FBIHTENL. S, Bl RS ATRE FEETE kAR
(1) ATERUE T rHLIRAS T T @ Smsssumi.
(2) Mt 5] > (HTEDRLES R eiT @ -
(3) wkmBSRAE, T @ -
FTENHLE A &

[ 21578 ([391F)

(4) Shtessida, VIR,
(5) Mg Bk IRk, FFREBhITENHL
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H BT BN S

QIEHTENEHE I TEA 2 F, "EH] Brother 7 " A FH AN IR " TEHRE AR N AR e
S Brother Pk BRI HFRRY, (EZANRAE AN AOR R, AR 4 MR RRR AT, LRSS
AT TSR, AT 1O A R PP A B,

{#F Brother f= i}
RN HRER? ZHALE
GTX Graphics Lab Graphics Lab 1 i i+
A8 P LAt L AR IS
S I N R ZHALE
CorelDRAW(X7/X8) "5-2-1. CoreDRAW >>P.54"
Adobe Photoshop(CS6/CC) "5-2-2. Adobe Photoshop >>P.61"
Adobe lllustrator(CS6/CC) "5-2-3. Adobe lllustrator >>P.66"
Adobe Photoshop Elements(14/15) "5-2-4. Adobe Photoshop Elements >>P.72"
(%]

o IHMMERSRAIREFIORE, & E N R B B AT B
o A& RGB=(254,254,254)it ik A"RGB=254", RGB=(255,255,255)it.i4 A/"RGB=255""
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QT BN A

Bt (B

GTX-4 $TEIFL N RGB EA4FTEIHL,

B RGB faU G SR, HRHEFRtEIE GaN) 15451 E N sSRGB(sRGB IEC61966-2.1).
[5%]

o {4 Adobe =¥ Corel [{IR AR5, CMYK B B AT R o B %

o HIffitE RGB#F, WIS{#F Adobe RGB S5 E4MNII IR, IFIREST A I AT

FTERHERR

BT EIS o AR RAUS A AR T, RS BV

SRRSO i 19"Brother GTX-4 FileOutput'sTEPHLIRERE A3 T EN F A .
[(5%]

o EENTEMRBETEER, RIS GTX4 FTEWLEEN PC MBE BTN,

H EEE IR

B PR A F it S0 b SR EERTENEARR, K RGB=255 {EN"EM " AbEE, Amg s,
AHZLAE ] A i ST RS A SR, &y RGB=254.

[Z%]

o HUERIIRY, RGB=255 MALMIIEN, HiEA .

ARX4 ({4

1 F SOy HE R 4" Brother GTX-4 FileOutput"$T ETHLEREHFEFE LA ARX4 # 2U5AF
WL, ARXS #U0RAF,  TIAT LARRIAST BRSO S B A s F =
[Z%]
o WU, 1EEHATERYLERENFER " Brother GTX-4 FileOutput”. il & AR FFHE R FI[Print to file]ts 44 Sof,
W SCAERT R A4 A arxd,  BLATRETCIAE & U A B
o GT-541/GT-782/ GT-3 RAIMFT ENERE VL@ GTX4 $TE,
o WHNEN PC FEhil AR B EATEIHLIRSNFET, WITES N R PG N A 2. FTENRTIEMIAST ENFLORSIARE 7 A B L
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5-2.  MEAhN R BT DR

5-2-1. CorelDRAW

#1814 CorelDRAW $4T LA R
o PiAINE
o FTEIRSF
T ARYE T AT LA T HRAE
o BIEITENEEE (ARX4 STHP)
o fEHISFERAE A I bR
o HGCHALIERS
o HAIEIF I RGB=255 ¥ty RGB=254 Iif

(%]
o KHLHHEFEEF CoreDRAW X7 / X8. ifEid CorelDRAW X7 13t BH &/~ H [ o

B E
(1)  MSEHFLF Ik [Tools] >[Color Management]>[Default Settings].

(2) [Default Color Management Settings]i#-47 L F % & .
e [RGB]: [sRGB IEC61966-2.1]
e  [Primary color mode]: [RGB]
e [Rendering intent]: [Relative colorimetric]

Default Color Management Settings X

Presets: [Custom -

Default color settings Color management policies

Open:

RGB: (Default) sRGE IECH1966-2.1 - l RGE: lUse embedded color profile v]

CMYK: (Default) U.5. Web Coated (SWOP) v2 - CMYK: ’ Use embedded color profile VI

Grayscale: ’(Defﬂult} Dot Gain 20% VI Grayscale: ’Use embedded color profile VI

[C1warn on color profile mismatch

Primasy color mode: (S5 [C] Warn on missing color profile

Rendering intent: Relative colorimetric Import and paste:
Color conversion settings RGB: ’Convert to document color pr... vl
o [MlcrosofthM EhiM '] CMYK: ’Assign document color profile vl
[T Preserve pure black . I ’C — — l
4 - ¥
Map gray to CMYK black rayscale: | Convert to document color pr.
[7] Warn on color profile mismatch
Spot color definition: [Lab values '] [ Warn on missing color profile
% Description

Choose the default RGE color profile for new and untagged documents.

OK ][ Cancel H Help
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FTENRSF

(1)  MSEHA=rhigEFile]>[Print].

(2) F[Printer]i% & }y"Brother GTX-4"5{"Brother GTX-4 FileOutput"iF ffEE— ", Ai[Apply], S<HI[Print]*HiEHE.
(%]

o [Printer]#% & N"Brother GTX-4"f, FTENIFTENSHRE &3%EZEHTEIAL.
#4[Printer] % & Jy"Brother GTX-4 FileOutput"iif, FTENIHT ENEE LA ARX4 SCAHFAT

| Print

X
General | Colar I Composite | i.ayontl Pn:p:ﬂsl 3z Nnksua|
Destination
Printer: [Brothel GTX-4 FileQutput v] [ Preferences...
Page: [ Match orientation (Peortrait) 'J [] Use PPD
Status: Default printer; Ready
Location: GTX4FPort
Comment: [F] Print to file
Print range Copies
@ @ Documents Number of copies: 1 =]
() Current page Selection I
Pages: |1 @@l Collate
| Even & Odd - |
[T Print as bitmap: 300 | dpi
Print style: | CorelDRAW Defaults v| [ Seveds. |
[ PrintPreview | ([ ok ][ cance Apply Help

(3) MEHALrhikiF[Layout]>[Page Layout].
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(4) [Page SizeliHTLA N3 HE.
e [Size]: [Custom]
e [Width]: 355.6 =X
e [Height]: 406.4 =X
o FTEIRTIIE: YA
(%]
o KGR E NIRRT ERAARER] 14%16 AR .
KF MR HEUE, 1HS"5-3-1. EFEERNT >>P77"
Options X

- Work [ g
T Page Size

- Document
- General Size and orientation
- Page Size S
- Layout 2=
... Label Width:
. Background
- Guidelines Height:
. Grid
- Rulers
.. Save
Show page border
.. Export To HTML M=
- Global Add Page Frame
Resolution
Rendering Resolution: 300 * dpi
Bleed
Bleed: |00

[7] Show bleed area

[ ok ][ concel |[ Hep

BIEATENEEE (ARX4 30f4)

DL ARX4 #&% K UGB AT B AL B N A E T B (A
AR ARXA SO JE AT CAEAT DL A
o A LUK UG AN T B B B — AN SR AT
o AILIANES: PC M USB fififids EEEFTE.
(%]
o ARX4 MTiEgmEEIE . ES 0K EIGBIE RN -
o IHIES N FHFERFHES TI[Print to file]ts & T RETCIETR e SUiH s SO R AL BN B4 . AT AT ENHLIKEI A2 " Brother GTX-4
FileOutput".
o MWNHREFEFERFTENURESHER, 1E5H"6-6-2. M HAhN FHFER R&4T ENEdE >>PA137",

(1)  MEEAiEEFile] > [Print].
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(2) FTH[Colorts%s, HATLAFRE.
e  i%H[Use document color settings]
[Color conversions performed by]: "Brother GTX-4"5"Brother GTX-4 FileOutput"
[Correct colors using color profile]: [sRGB IEC61966-2.1]
e [Rendering intent]: [Relative colorimetric]
Print X

|Genelai| Color | Composite | i.ayoutl Prep:msl 152 Mo lssues

@ Print composite

(@) Print separations

@ Use document color settings

() Use color proof settings

Colar conyersions performed by: [Bm:hﬂ GTX-4 FileOutput

Ciutpu o 51
Cutput colors as |RGE

|| Convert spot colors to RGB

Correct colors using color profile: | (Document) sRGB IEC61966-2.1

|¥/] Preserve RGB numbers

[#] Preserve pure black

Rendering intent: [Reht'nre e

The color settings and preview available in this dialog box are set for the Windows Graphic device
printer that you selected on the General tab.

[ Print Preview | [ib] (o ][ cancet |[ Apply ][ Hep

(3) FTH[Generall#z2%, M[Printer] ik 44 H H"Brother GTX-4 FileOutput",
(%]
o HREXGI[Printer] % B A"Brother GTX-4"I, $TENARE &% Z=ITEINL.
48 E RS I[Printer] i3 & 4" Brother GTX-4 FileOutput"iif, FTER%HRLL ARX4 SAHFAE

(4) 1E[Preferences]+ 1 BT EIHLIRSIFET -
(%]
o THNEIESIR"S-3. WEITHWIIRSET >>P.75",
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(5) 4% F[Print e HEHERIOKYE, Eom A FXEHE. sk A7]
(%]
o AIRERTEEJ LB EIIA].
f Brother GTX-4 File Output MER
AU : GTX422
ji3=H IMG_1404
I HAR 06/25/2017 22:47
EAfRR T 14x16
A 1200dpi x 1200dpi
RS FE+OBnE
=5 5
b 3
B ) i
BEHEE: 400 %
FREHAES: Off
HERMEAREZITE: off
HEME: 097cc 100% [}
BEmE: 865cc
1EN: 13k
BTE
LE2E
a5

1 WsCMYK  ~ | CIa&#iR
[

(6) FRE[MRIFAEINICIFA] [RAFIARXA SCIF-

5 P SE A R R EAR

(1) #%H&"5-4-1. Adobe Photoshop. Photoshop Elements. lllustrator. CorelDRAW FiifAtatR >>P.90", 7& PC H{RfF
CorelDRAW Fffif it SctF ("GT_Colors.xml"FI"GT_Tshirts.xml").
(2) MSEEAFIPIEFWindow]>[Color Palettes]>[Open Palette].

(3) P4 "GT_Colors.xml"F1"GT_Tshirts.xml".

(%]

o 1EZIf{H HKS. Pantone S EFEA AR I, 753 IUimi I T ENLE AT BEAN Ao
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(1)  MSEHALh Ik [Bitmaps]>[Convert To Bitmap].

(2) ‘¥4[Color mode]¥ & N[RGB Color].

[Z%]
o FEHEMMSBITEN, Ki[Anti-aliasing] ¥ R UAHERHILES -

Convert To Bitmap X
Resolution: 300 - dpi
Color
Color modgll RGB Color (24-bit) -|
[ | Dithered

[ | Ahways overprint black

Options
[V] Anti-aliasing
Transparent background
Uncompressed file size: 1,46 MB
| ok || cancel || Help

(%]
o HNfE MFTENHLIRSIAE 7 ik B8 1 EAR N, [Page Layout] 7] 545 A[Settings from printer].

s RN SHE[Page Layout]H 5 e 5 FE AR -
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AL ) RGB=255 %4 RGB=254 i}

RGB=255 5 MiE . B8 RGB=255 [{13 /0 ANt HijH 52 .

TENA G, i%i%E RGB=255 fIX i # y RGB=254.

TR LR it T 8 4.

(1)  MEEHALrhik i [Effects)>[Adjust]>[Replace Colors].

(2) M[OId color]#) Nz fidi[More], 7E[Select Color]HF# & A RGB=255.

QAT ENidls

RGB=255

; - Select Color X
E] lz] W Models [ Mmelslﬂ Palettasl
Options Color Mask: odel: [RGB~ S T .
Et n— DMdJ [ ——
New color: [ [ [T Single destination color
-t 0 /
R 5 (fj R 25
Saturatio D 0 G 255
Lightness I 0 o 8o
Z] N B
Range: D 30
Name:
! White -
) ) e
Add To Palette [vH Options H oK H Cancel Hel
(3) HFEEERJT i [New color]i% B & RGB=254,
(4) ¥[Range]i%ERN"", rid[OK[%4H.
Replace Colors X

[@)=)

0ld color: H Options Color Mask:
[T]1gnore grayscale
New color: H [ Single destination color

Difference Between Colors

HUE """" L o B | D Trrrr | { B | U
gatur]tiﬂn: T D L i | 0
L|ghtne55: TTT “ L e 0

B,]ngg U I I I e

| Preview | | Reset |

(%]
KRR, EERReHETE NN RGB=254,
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5-2-2. Adobe Photoshop

i#ifid Photoshop #1447 LA T4k
o PhNE
T ARYE T BT LA T HRAE
o QIERFTENEIE (ARX4 Ui
o fEHISAEAE A I bR
o} RGB=255 &y RGB=254 i}

[Z%]
o B8N CMYK i, i AR H =ik Image] >[Model#4#ih RGB % (sRGB). Eid Sk HA~H1¥[Image]>[Adjustments] 1]
SCHYRRENE, SURHT LIRS I E R SGE (SHE"5-3-9. WEER >>P87") KA.
o AHLHHEFHEH Photoshop CS6/CC. iffiid Photoshop CC il B RE [«

B E
(1)  MSEHALhiEFF[Edit] >[Color Settings].

(2) [Color Settings]iZEfTLL F X HE.
[Working Spaces]
e [RGB]: [sRGB IEC61966-2.1]
[Conversion Options]
e [Engine]: [Adobe(ACE)]
¢ [Rendering Intent]: [Relative Colorimetric]
[Color Management Policies]
e [RGB]: [Convert to Working RGB]
e [CMYK]: [Convertto Working CMYK]
e [Gray]: [Convertto Working Gray]
e  [Profile Mismatches]: &A1 [Ask When Opening]. i%&#1[Ask When Pasting]
e [Missing profiles]: i&[Ask When Opening]

Color Settings u

Seftings: Custom

Working Spa

Intent: Relative Colorimetric  ~
Dot Gain 15% se k Point Compensation
Spot: Dot Gain 15% se Dithe fchannel images)
Compensate for Scene-referred Profiles SR
Color Management Policies
ert to Working RGE Advanced Controls
Dasaturate Monitor Colors By:
Blend RGB Color

Blend Text Colors Using Gamma
Ask When Opening Ask When Pasting . ==

5 Ask When Opening

Description
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BIBFTENEHE (ARX4 34

LA ARXA 1% 30 UG HU R A T BB E N B 9T BN R AT«
A2 ARXA SR AT ABEAT BA R A
o LR EUREERAIT ENBCE B 2 — A ORAE
o WLIANER: PC M USB f7fifids ELEATE.
(%]
o ARX4 VHTREGEENE . EF e BUEEEE R AR .
o ENF TR [Print to file]H5 4 AT RETGIFE S SR g AL AT e 4 . E AT EMHLIR BN Brother GTX-4
FileOutput”.
o MWEHAEREERFTEWURIEEARR, ES18"6-6-2. WA R AT ENgdE >>P.A37".
(1) SRR SE[File]>[Print]. PC — (i K4 EIFL " Brother GTX-4"8k"Brother GTX-4 FileOutput'tf, ki E
NS
(2) HATLLTEE.
e [Color Handling]: [Printer Manages Colors]

e [Rendering Intent]: [Relative Colorimetric]
Phaotoshop Print Settings g

Printer Setup

Printer:  Brother GTX-4 FileOutput

Copies: 1 Print Settings...

Normal Printing ~

Rendering Intent:  Relative Colorimetric  ~

~ Description

(3)  M[Printer]F iz {44 Hi H"Brother GTX-4 FileOutput".
(%]
o ¥f[Printer]i% & A"Brother GTX-4"i}, FTEIAERIEEITEINL.
¥ [Printer] i3 B A"Brother GTX-4 FileOutput"fif, FTEP%E LA ARX4 SCHHRAT

(4) 7E[Print Settings] & BT EIHLIRBHFET -
(%]
o WEMFMIANFIESIR"S-3. WREITEWLIKSIET >>P.75"
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(5) F& F[Print]/5 R LA RXHEHE. s [PRAT].

(%]
o HIAERE) LB AL

9ad’ Brother GTX-4 File OutputTiSE R

L

FEE=H
EIHAR

EARRST
DWE:
S AR
=ha
HTEMAiE:
HEhES:
FRARHEEE:
RS AEETE:

LEME:
BERE:
FIED:

#7F

GTX422

IMG_1404
06/25/2017 22:47

1416
1200dpi x 1200dpi

PE+OshE

097 cc
865cc

15k

20

100% (]
BT
EEE

[ <) o
—

(6) FREIRAFAEIMLIFA], [RAFIARXA SCH.
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5 P S A R R EAR

(1) F%M%"5-4-1. Adobe Photoshop. Photoshop Elements. lllustrator. CorelDRAW FHifitatik >>P.90", £ PC {47

Photoshop FffIi ik SCH"GT_Colors_T.ase".

(2) MEEHAFLRIERWindow] >[Swatches].
() AMhw=, T TER.

Swatches

RGB=254

(%]
THZI8H HKS. Pantone S5 EFEA tuti P IR, 75 0 e And T BN EL AT REAN ] o
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# RGB=255 #&#i5 RGB=254 i}

RGB=255 {15 A& W (. {5 RGB=255 4 At i,
FTENEA T, %% RGB=255 [[X 31 #ly RGB=254.
TEE ] DA R 77 T B e

(1) EESEEARA K [Layer]>[New Adjustment Layer]>[Selective Color] & K2 .

(2) BAEHIFEBE N 20% I mih[OK].

MNew Layer

Use Previous Layer to Create Clipping Mask

[X]None

Normal

(3) fE[Selective Color]H {7 LA Nt H .

e [Colors]: [Whites]
e [Black]: 1%
e i%&rh[Absolute]

(%]

LA, 4% RGB=255 £y RGB=254 ffJ /77, {X[Color mode] [RGB Color]{{J[8 bit]i il fil.

Properties
m u Selective Color

Custom

Relatve O Absdute

i1l Photoshop # RGB=255 ¥ & RGB=254 [z 3 :"SolidWhite.atn"7ESZ %4 (Z:[8"5-4-2. Photoshop FIZHESC
ff >>P.90". KT, 15588 Photoshop fI7EEf.
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5-2-3. Adobe lllustrator

THIEL Nustrator 447 DL N A
o PihNE
o FTIFECH

AR 75 AT L T
o GIEFTENEHE (ARX4 U
o S FER AR A B  EbR

[Z%]
o bR EUEBHEAESTENVEREN, EUGHER KGR, T ME—#RAE,
- JABENRTEE PC — R FH 3T EPL Y B A "Brother GTX-4"8{"Brother GTX-4 FileOutput"s
- JBid"Brother GTX~4 FileOutput"{T EHLIRSAZ 1 Hh SCAFHE TRGAfIA o
o BB NCMYKIH, iE# K432\ Photoshop, i@id 3 Hi i () [Image] >[Mode] #4454 RGB 1. % (sRGB). 734+, i 2\ Photoshop
DA P g S BB T EPY LIRS AR P (i s (SHR16-3-9. IR E R >>P.87") KA.
o AHLHHEFEMS A llustrator CS6 / CC. i llustrator CC 1B Z R E [ .
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B E

(1)  MSEHALRIEF[Edit] >[Color Settings].
(2) Ai[More Options].
(3) W F AR T R E I A [OK].

e  [Settings]: [Custom]
[Working Spaces]
¢ [RGB]: [sRGB IEC61966-2.1]

[Color Management Policies]

[RGB]: [Convert to Working Space]
[CMYK]: [Convert to Working Space]

[Profile Mismatches]: i+ [Ask When Opening]. #+H1[Ask When Pasting]

[Missing profiles]: i%H[Ask When Opening]

[Conversion Options]

[Engine]: [Adobe(ACE)]
[Rendering Intent]: [Relative Colorimetric]

-

Color Settings

o synchronize, select Color Settings in Bridge.
Settings: ' Custom
Working Spaces

RGB: ' sRGB IEC61966-2.1

Color Management Policies
RGB: ' Convert to Working Space

CMYK: Convert to Working Space

Missing Profiles: ¥ Ask When Opening

Conversion Options
Engine: Adobe (ACE)

Intent:  Relative Colorimetric

ﬂ Hald the cursor over a setting for additional information.

Less Options

CMYK:  U.S. Web Coated (SWOP) v2

Profile Mismatches: ¥ Ask When Opening ¥ Ask When Pasting

¥ Use Black Point Compensation

@ =% Unsynchronized: Your Creative Cloud applications are not synchronized for consistent color. To

Load... Save...
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THH M

(1) wEH .
e [Width]: 355.6 =X
e [Height]: 406.4 =X
e  [Orientation]: ZAInl
o [Color mode]: [RGB]

o KA ENMERI AR . IR OARER] 1416 AR IR .
KRTPEBRFCTREUE, S HE"5-3-1. SRR >>P77".

New Document

Name:
Profile: [Custom]

Number of Artboards: &

Size: [Custom]
Width: BE: Units:

Height: Orientation: [

Top Bottom

-

Bleed: | 5 |1k -
~ Advanced
Color Mode: RGB
Raster Effects: High (300 ppi) v
Preview Mode: Default v

Align New Objects to Pixel Grid

Templates... Cancel
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BIBFTENEHE (ARX4 34

LU ARX4 % 2GR BB B ANIT ENBEE A A I T ENER R AT

Al ARXA SCIFJE AT LABEAT LU T #A

o HILLRFEMEHURAT N BV BN RAT

o HTRIANESL PC M USB f#fifids EAEATEN

(%]

o ARX4 XMTCEGEEIE . e R G EEE R N G .
o EMAN IR HER HI[Print to file]fs & T RETCIE TR E SCAH T O SCAH AL BANY R A4 . 1 SEFIFT ENYLREh A" Brother GTX-4

FileOutput”.

o NWNHIRERFEAEFITEWUACREEER, 1§51"6-6-2. AN HIFEFFAIZFTENEdE >>P.137",

(1)  MEEAL%FFile] >[Print]>[Color Management].

(2) HHATLUNBES

o  [Document Profile]: [sRGB IEC61966-2.1]
e [Color Handling]: [Let lllustrator determine colors]
e  [Printer Profile]: [sRGB IEC61966-2.1]

¢ [Rendering Intent]: [Relative Colorimetric]

Print

General

Marks and Bleed
Output

Graphics

Color Management

Advanced
Summary

Setup...

Document: 14 in x 16 in
Media: 14 in x 16 in

Print Preset: [Default]

Printer:  Brother GTX-4 FileQutput

Color Management

Print Method

Document Profile:
Color Handling:
Printer Profile:

Rendering Intent:

SRGB IEC61966-2.1

Let Tllustrator determine colors

SRGB IEC61966-2.1

Relative Colorimetric
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(3) M[Printer]F ik 444 FH"Brother GTX-4 FileOutput".

(%]

o ¥f[Printer] % B N"Brother GTX-4"i}, FTEIAERIEEITEIL.
#[Printer]i5 B A"Brother GTX-4 FileOutput'ff, #TEIEELL ARXS SCHHRAE

(4) fE[Advanced] i BT EIHLERENTE o
(]

o Adobe lllustrator i, &3S HIRE AT ENXTEAE P AOZRGK IS i B RAR R AT ETBCEHEHER B, ATRETCIA LR

BERB R CE.
(%]

o WEMMARESIE"S-3. BTN >>P75",
(5) I F[Print]5 Eon A RAHEHE. AR AT

(%]
o AIREFEJ LB ITIA.

r]ﬁ Brother GTX-4 File OutputFi:SEIE
LEL G GTX422
HEd: ING_1804
FRE 06/25/2017 2247
EtRRT: 1416
HEHE: 1200dpi x 1200dpi
SR R+ OEnE

S 5
B E
FTENA 5] xl
AEmEE: 400 %
FAEHORE: Off
HERMESEETE: Off
HEME: 0.97ce
BEmE: 865ce
FIE0: 13k
o

100% [}

BTE
HEE

1 WsChMYK  ~ | CIa&siE
[—

(6) FREMRIFAEINICIFA] [RIFIARXA SCIF
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(1) #%l#"5-4-1. Adobe Photoshop. Photoshop Elements. lllustrator. CorelDRAW fifi itk >>P.90", 7E PC H {47
lllustrator A iR SCHH"GT_Colors_T.ase".

(2) MSEFAR ARG Window]>[Swatches].

(3) mMiiw=, & T3 [Open Swatch Library].

(4) EF[Other Library].

Swatches

(5) 1E[Open]iHEifiHiE# {4 "GT_Colors_T.ase".
(%]
e Zfhhr5 Photoshop il CorelDRAW M|, FBAEmF AT H SCAET 4
{EE, {4 NlustratorCC I, I LA R e (AR, 0B BIRFINTT ELE 30 5.
MR WSS, R TR E].

GT_Colors_T Add to Swatches

Sort by Name
Sort by Kind
v | Show Find Field

¥ | Small Thumbnail View

AJJJAEJJJJA!J g o
3 Medium Thumbnail Yiew

AJ!JJ&AJ.‘JJ'
Large Thumbnail View

Small List View
Large List View
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5-2-4. Adobe Photoshop Elements

i&ilid Photoshop Elements 147 LA R/
o PUfAINE

TEMRE 5 AT DU R
o QIERFTENEIE (ARX4 Ui
o RSB R R

[=5]
o AHLH#HER{ER] Photoshop Elements 14 / 15. i Photoshop Elements 15 i W &7 i T «
P E

(1)  MEHF:rRIEFEdit]>[Color Settings].
(2) M[Color Settings]+i&£¥[Always Optimize Colors for Computer Screens]F 5. #{OK].

Color Settings b4
& Learn more about: Color Settings
Choose how to manage color in your images: Reset

) No Color Management
(=) Always Optimize Colors for Computer Screens
O Always Optimize for Printing

O allow Me to Choose

Mote: The "Mo Color Management™ setting will ignore and discard embedded color
profiles if they exist. The other settings will utiize embedded profiles or convert
to sRGB or AdobeRGB, if the embedded profiles cannot be supported.
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LU ARX4 % 2GR BB B ANIT ENBEE A A I T ENER R AT
Al ARXA SCIFJE AT LABEAT LU T #A

F LR G ERAN T DB B B SR R AT
FPAAESR: PC A USB {7t ELIEATEN

(%]

(1
(2)
©)

ARX4 S TIEGwAER R . TEFSR RBEUR R g ] .

QAT ENidls

L% FH R P AE 5 H[Print to fileJi 4 T RETGVATR R SUPHAIH B SCPFI AL BRI g4 o S FIAT ENPLARE)RE 7" Brother GTX-4

FileOutput”.

MR ELERIAF TEN LR AR, 15 SHR"6-6-2. A AR 7 RIEHT BN >>P.137",

MR iR [File] > [Print].
i%&FF[More Options]>[Color Management].
BATLL N CE.
e [Color Handling]: [Printer Manages Colors]
e [Rendering Intent]: [Relative Colorimetric]

wuMoce.Options

Printing Choices Color Management

Custom Print Size

Lo MalaUemErt
Color Handling: | printer Manages Colors |

Image Space: sRGB IEC61966-2.1

Printer Profile: | Adobe RGE (1998) -

Rendering Intent: = Relative Colorimetric v

in the printer preferences dialog?

[ Did you remember to enable color management

| Printer Preferences... |

oK

|| Cancel || Help

(4) ERATEMHLAE RSO I "Brother GTX-4 FileOutput”.

(%]
o H4[Printer] 3£ E N"Brother GTX-4"}, TEN%HE AIEZEFTEIHL.

H[Printer] i3 B A"Brother GTX-4 FileOutput"fit, #TEI%ELL ARX4 SCHHRAT-

(5) TE[Printer Preferences]H & BT EMHLIKSHFLT -

(%]
o WEMTHHMNEIESH"S-3. WETEHIKIERF >>P.75"
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(6) % N[OKE T n L FAHEHE. Mai[fRAT].

(%]
o HIAERE) LB AL

f Brother GTX-4 File Output MER

AR

f58:
=Lt :RIEE

EtRRT:
fat ]
hEEE:
=t
ir g
FTENEE:
BEHEE:
FFEREEE
¥ BAIRARZTE:

HEME:

AEMmE:
1EN:

GTX-422

IMG_1404
06/25/2017 22:47

1416
1200dpi x 1200dpi

HR+OREBE

100% [}

BTE

ERE

1 WsCMYK  ~ | CIa&#iR
[

(7) FRERAFAEINCAEA], [RAFIARXA SCH

Ao S PR A T A R

Photoshop Element 13 7] LA{i F Photoshop H Itk "GT_Colors_T.ase". #4415 2| "5-2-2. Adobe

Photoshop >>P.61".
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5-3. WEITHNESET

(%]

o GTX4 fTEMHUINAITETH RGB=(255,255,255)F " Wi (" AL B, ANt AHZAEH A G sR4TEN el A e R BRI, 7Bt

N RGB=(254,254,254).

o RTHOHEBHINE EAEE"S-2. WHAS IR QIRITENEEE >>P.54"rh & N R AR DT N AR 7 Bl

(1) RSN IREFPRHTES TR, SosdTEILAREIRE A AOF T ENS E XA

[ s =50
ke | BRRE
W ERE:: [GTx4z2 -]
EFRT: (1416 - [ mmsE |
BRI E+aERE -]
i @ REE O AEMESE
FHE: @) 1200dpi x 1200dpi
E@imii&ﬁ: 1 3 5 7 g
=3 D 5
1 2 3 4 5
B D 3
FIEMRRE: | =1 g&:‘ﬁii 400 %
[Cla@a4en
[ a@ga--aiEn
CHAEMMES (EETihER?
CIREMESKEEIE Eir#E
RS
PR TR
[ m= | By |
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(2) AT EHLIRBIRE P ST E B B XA REAT TG B
VA E], FTREE A O] [WFE]. [T

(%]

o WRME[MARERE: VEREMNEAR, miT R E T H A,
o TEXSIEHE MRV MBS RN EE R, B ARTEE, AR,
o RTHRUWEIHIWY, ESRLUGHET.

[Brother GTx-4 #miaEma =)
BEASME
TR B green (0,199,0) sl .
B OEAES: OF:4 B
1 2
D 1
01 2 3 4 53 6 7 8 9 10
BERBNNIREE: i 2
EELE
a 10 20 30 40
P - [ 5
=E: D 5
T 1 5
YT
54 -3 -2 -1 0 12 3 4 5§
#a: 1 o
g=F B 0
#=E: D )
23 1 0
[C] &rTER
[ e | [ s
(3) WELHIE SEHE]
(%]
e M'GTX-4 File Viewer"sF T T ARX4 At 5 v 3 HE AL ¥ B I
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5-3-1. EHEERNT

VNI TOANG R |1 i e S e N G )R TN
(%]
o BT SARIKHURAR Y .

BEEUH Ao FH AR

R

[16x21] 16x21 [EHT

406.4 =Kx533.4 =X

[16x18] 16x18 JEHR

406.4 Z=Kx457.2 =K

[14x16] 14x16 Hohit

355.6 ££x406.4 =K

[10x12] 10x12 JEH#T

254.0 2K*x304.8 =K

[7x8] 7x8 iR

177.8 Z=£4%203.2 ZXK

r wa
= FTETESIE

kR | EFRE

AR :

[EAfR T

HEEE:

st

HHE: @ 1200dpi x 1200dpi

ABRERE: 1 3 5
Bk 0

[ BEARATED 10
FTENIENG f0):
Caesa-BHTen |
FTENERR G):

CFARHNEE (EeTiER)
B =l p)-r=r sl

ERRT:
SEAH TR ERRIERRIR T -

1621 (406.4¢533.4mm)
1618 (406.4¢457 2mm)
14016 (355 6x406 4mm) 3 4E3E
1012 (254.0304.8mm)
78 (177.8x203.2mm)

i

femE: [ geas

40

|4DD %

ETEE

[ wmE [ mE |
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5-3-2. EPEMSEFR

AN R B s e T LS vies e LA MHE DA ERE

BEIH

Wi

PRt + A il )]

FE AR EATERE ORI,

[(EeSEAES)

R A G, TERAEE.

(Bt 28]

FE FREIR R AT LR R

[ ey 2]

ARG, TERARE.

i STEDESIES

HERRE EFRE

nEsE=:

ERRT:

HERE:

s

BHE:

AElERE: 1 3 5
ot 0

E]w

[ A& RETEn L 1 ) 1
$TENERR AY):

[ ==TE 7= 1= 020 A0
ATENERR A):

[(#ARMNEE (E&ThER)

(¥ EHEARRIETEN

-
5|—
0
°

BEREE

SRR :
A RS T o

%ﬁ% é BERE: T‘E% E%E’]}E?‘EEJ:HEH%EEIE&
pez=h Ei T'EIJEEE SRR CHTENT /AR -
RESMmE: JERESNE, TEIRAEER

HH

}
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5-3-3. EPEER

K RE A QI SENIREE, BENRBRA R B iR, AR SR e

(%]

o IREBUAHIAR, SERMEIISEE AT RE TR,

femsd: [ peak [won

SEETYS IR
$TEDiENE )

Cagmacgye 0 0 o 0
fTENiEhs RY):

I HARHNEE (BETEA)

40 2 BC
B0

IRE: @ 1200dpi x 1200dpi
HElERE: 1 3 5 7 9 1 3
= [ 5
1 2 3 4 5
B [ 3

—
—

¥ BMEARHEITEN REREE

flist:
B ghiﬁﬁﬁﬂﬂ"]f’:‘l BHEE, MHEFGENEEREE.
B2 HiBH2, RaemEEaNERRREEHR-

[ rEnmiEm ]
ik HE | EFRE
s (aTxaz2 )
ERRT: (1416 - [ iameE
BERE: WB+aEaE -]
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5-34. EARME

DSRESRE: FPEFR O+ A SR s Al R, Son[AEumEnE: 1WiETH .
FatymEEs NG 1 (Tl AtmEE) MEE: | (HTFESRMEGER A tmSEs) A%,
AN, WE[ABSUITE: TR A /A AT BB g S8 a)

[ TE0mER -

isk/mE | EFRE |

g [aTx422 =
ERRT: (1816 - EEEE |
HEEE:
3 o RE BEhEHIR
HHE: @ 1200dpi x 1200dpi
3 I
u
1 2 3
J
FIENESiE: | x1 égimi 400 %
=127 i)
BE/A/8 M BHTED
# ém5¢ﬁ1§#15ﬂ | GEREE
ERRT:
IEFHTENR ERMNERTIR T -

16x21 (406.4¢533 4mm)
16x18 (406.4¢457.2mm)
14x16 (355.6x406.4mm) 2 EE
1012 (254.0x304.8mm)
8  (177.8¢203.2mm)

(@ [ m& |
=i
MII~Q1Z ik RGB=254 [IAE R, {Hlk, A,
EER EE HEE
1] H taih a5 200%
[2] s 250%
[3] {0 2 & 300%
[4] O 2R 350%
[3] i s 400%
[6] i S8 i 450%
[7] {0 2 500%
[8 i 2 5 550%
[9] 8 600%
[&%]

o RE T HMBEESMBEAR, K EEREEEAR. @RS ARG SR EE, RRSEITEdE. H2"5-4-6. 1TH)
FOUERZE >>PO3TE R A RIZ, EHm R E .

o MRME[EDG: | [ROMEEHAITEMRE, [FTEE: KA GmEE. R4,

o [MDt: IWEMADG) ROMESHZITENORF I, [FTENNE: [N[x1]. R AWENZEAMEE, SontTEN R L.

o SKPRMERHFEREDR TITEN RGN IER . SR SRR AhriE .
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INTTI[5I o o SR P 5 € S
WEE T
[]5k12] G T R G DR .
[3] BRI
TR, K, BEOERR.
[4] ETL, %0, GOSFHRIRG. IRRH G,
[5] TERE LK LLSNFT A e R LUK (1 Gl T
HEMRITED

HESUATEE RS, WIEL] T (18] hidE mot.
WE MR TR — 2 A G EER A TR 2 A Gl SRR H,
AN RAE FEA TR — 2 SRR (], DEANROFELES R 0 FD,

(%]

o (N[MERULEE: JPIEHR 4 A th SR EX Bt SR T DA E

At | B HETH

BEETHURATEIAT— B il SR R BT ER Cuith 282 AR o
A SRR LT ENRG— 1 i 22 SR A TR, USE AN LN [0 O 70

(%]

o (U[MSEMERR. RO+ E AR DL E.

o ITEMUNIEIBRIN EELEE .
o ITEVNEURESHT

k. M, ITENAGZR)E, EiF GERHRTED EITHRAE.
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5-3-5. FIHEMIKIEE
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5-3-6. WERGHEHEGEEITE

st iR+ aEmaE]. (O Ch s B SR h RS — M, BORD ORI A R AR T EN B E 0
Ho
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5-3-7. WERMAME
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HEE
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WEE T
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[Z%]
o JTHE THMDAMOARIES, SNEbrisaE)s, ARNhsERE: [HIE.
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2 JATED

IYR 2 RATEN, EHEERM

BEE Wi
0] AP UATER
(1] SMRATEND G 1IR3 2 I 1Al ST Ta)D
[2] SPURATEN G 1 RSG5 2 U 1154 1] EL e A SR TR
(3] SPURETED B 1 RS ER 2 Uz 1SR 1] EL s N[RI I SR TR
(%]

o [MMBIEMEA 2 K.

o WEMEMK, FTEIRFAHK.

5-3-8. WEHMGMHE
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(4) fE[Preferences]| B E FTEMHIIKENREFF, 1% F[Print]AEHERI[OK]AA T ENEAE «

(%]

TFAN IR SI5-3. IEITEHUIKEIfEY >>P75",
B T [OK],  ATEMHLRICIETTARIT BN, 45 T T EDHLRHT ENFEER T AR T BN,
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HASTED

Adobe Photoshop
(1)  MEEEF: ik File] >[Print]l. PC —Rfii AT ENPLA"Brother GTX-4"5"Brother GTX-4 FileOutput"f,
HeRR B AR
(2) BHATLLT WA
e [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

Phatoshop Print Settings u

14in x 16in Printer Setup

Printer:  Brother GTX-4 FileOutput
Print Settings...

ut: i B

~  Color Management

A Rem o enabl

andling:  Printer Manages Colors
Printer Profile:
Normal Printing  ~

Rendering Intent:  Relative Colorimetric  ~

~ Description

(3) M[Printer]iZ4¢"Brother GTX-4".

[5%]

o H4[Printer] 3£ E N"Brother GTX-4"if, TENEHE AIEEFTEMHL.

¥ [Printer] 4 & A/"Brother GTX-4 FileOutput"ii, FTEI%HE LA ARX4 SAHRAT

(4) 7E[Print Settings]H X BITEWLIRSIERE,  si[Print &35FT EVEE

(%]

o WEMVFMANFIESIR"S-3. REITEWLIKSIFET >>P.75"

o BMfERE[Print], FTEINIBICFFAETTED . 4 FATEINLAET EEet A4 e .
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HASTED

Adobe lllustrator
(1) Mk rhi%$EFile] >[Print]>[Color Management].
(2) #BATUUTNEE.
o  [Document Profile]: [sRGB IEC61966-2.1]
e [Color Handling]: [Let lllustrator determine colors]

e  [Printer Profile]: [SRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: [Default]

Printer: Brother GTX-4 FleOutput

General Color Management
Marks and Bleed
Output
Graphics Document Profile: sRGB IEC61966-2.1
Color Management
Advanced
Summary

Print Method

Color Handling: | Let Tllustrator determine colors

Printer Profile: sRGB IEC61966-2.1

Rendering Intent: Relative Colorimetric

Document: 14 in x 16 in
Media: 14 in x 16 in

Setup...

(3) M[Printer]+i&#"Brother GTX-4".
(%]
o Kf[Printer]i% E A"Brother GTX-4"iN, FTENAUEAIEEITEINL.
¥[Printer] i3 B A"Brother GTX-4 FileOutput"i, FTEP%E LA ARX4 SCIHFRAT

(4) fE[Advanced]H BLEFTEMHLIKANRET, sich[Print] AI&ST B .
[(Z%]
o WEMFMNRESES-3. REITOHERIET >>P75"
o EpREnii(Pring, FTERHLIATERITUATTED, # FATEDHLAGT BT 4T TED
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HASTED

Adobe Photoshop Elements

(1) MEEA A IESEFile] >[Print].

(2) % [More Options]>[Color Management].

(3) BATLATBE.
e [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

Printing Choices Color Management
Custom Print Size

Color Handling:  printer Manages Colors

Image Space: sRGB IEC61966-2.1

Printer Profile: | Adobe RGB (1998) -
Rendering Intent: = Relative Colorimetric v

1 Did you remember to enable color management
* in the printer preferences dislog?

i Printer Preferences... |

| OK || cancel || Help |

(4) FEFTEINLEFEH1E 2" Brother GTX-4".
(%]
o Kf[Printer] % B N"Brother GTX-4"i}, FTEIAERIEEITEINL.
F[Printer] % & "Brother GTX-4 FileOutput"if, FTENHE L ARX4 HAHRAF .
(5) fE[Printer Preferences] % BT EINLIKANFET, ri[OKIAIEST ENEHR .
(%]
o WEMFMANFIESIR"S-3. WEITEWLIKSIET >>P.75"
o BIffisil[OK], FTEMHIBTGIEITARITER . 4% FHTENHLIAT BRI 4RFTER o
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6-6-3. M USB RS NFTENEHE (ARX4 3C14)

(1) F5 USB {7 fi#iastili NERAEIAR AT USB A7 fdfds4d - -
[HZ]
o IHZEEHIJAEA USB fEik AT, I, AIRESUR.
[Z%]
o fiIHEAEN2GB~32GB LI, @it FAT32 #&:\{LH) USB f7fifids. TLUAEMT S IBItReSs 22T IRE M USB 12k ds.

. i USB fEfifgs st N BRI N ARXS #% s .
USB 1 28

X0038

(2) WORTEREIT AR, i T @ -
[(2%]
o EAEHCH BASIHE R

Ed-s)
ITEENES

FTEDMA

SERTENR
R
A

(3) EFHTERICIS, T @ -
[2%]
o [ ] R [ irehsmocrt
o USB1ERENIICHIREIS 3 2 NGRS 4 0L FOIIICIC,

o IEEIRTHE < FIFES
O Sample Foldert

lEI Sample Folder2 : O3 Sample Folder?

— PO Sample Folder3 = (O Sample Folder3
‘3 Sample Datal.arx4 ‘ Sample Datal.arx4
Sample DataZ.arx4 Sample Data2.arx4
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() FATI T B a‘me@o

[E%]
o ITEMZHINMRIAIE, E20MAE USB f7##S. IR SRR FEEEIR.
(%]

o HREEURRIAD, BHCRTRERE LB
o TCIEEHL USB TRifies A HISCIFRS, 1EZIA"9-1. KNS >>P224",
o FLIAREHEEIEAT . AREEIEESH"8-15. TR R3E >>P215",

Sample Data

# 14 x 16 inch
¢ 5. 45cc

SHEIZENOK
FTEREHIIRN S

142



6-71. FTEI13k

(1) BAATEEE.
BASOWIRATENZHELINKR, BAGERE, FHEnsm, $TEHIA AT -
FEEIPON 2 7, TIEIE 2R I ARONT T B (K L AR RS
(%]
o BT HZAETAREBUT AR, A
o BT HZHIAFEBRT EHRIT, A R

(2)  BIABUEA TR R ZETEN A, 4% N 3T RS4R3 TER
FTENSERE, REHARRS iR e T A AL B, A
(%]
o JEHCRIFTEATHZINS, BIfEL NTEIZEH], QOB R AL RTIREE), TITaRITEN . E R RIE NTEMHZH.

. F @ JEATETE.

o FEENIREEARASTHRIBLT, M AGMSBITEN, e TMHERIRET.
RIRIZATI,  FTENRFRIANSTENTFAG AT 4ED N 18] PT EAR <. AREARIRIZATHIBCENRT, TH2IR"8-6. I EGIRN fI4T ENS)
£ >>P.210".

o IRMGRAPNERS, ITENEGRUGRI4ES I ] REAR G, BoRIREEAEEE R ESE S, SHM0-1. RE >>P305", Hudsk
TR AR, AT S TENMRIETE .

6-7-2. ITENZIK

RAFATENEE, AIFTENZ 5K,

(%]

o UIWrBIEE, CRAMERORAF IR .

o M[WEATETHMILE SIMIERIT PR LB BRI, Sec e FKEITENE, FMIBRITEN S . A E I ER, HS"8-12. A3)
MIERITEN K >>P.213"

(1) AR AR s B TEN IR, 1% T T HHEADTARITED.
ITEDSERUE, KEHARES S SE T AT AL B, A T
(%]
o IRBURIATHHRTES SN, BRI HTEMZHE], (OB AR ATINEES), TEITAGITED. IS RHATE N T &AL

. HBF @ JEHTEL.

o RERIUHRHRARATENRITREL .

o TERENIBEAE 18CHIEET, B EMEITER, MRS YHR(RIEEIT.
RIESZSATHS, FTERR AT BN UG RTRIZED B T AT REAR K . AAFRIESATHI W BN, 15 SR"8-6. W EKIRF HIFTENZ)
£ >>P210".

o EHRMRHFAEENT, FTERZSH S IIL4ED I (R AT AR, BN AR R
JtiR BRI LR, A HAT AT B RIESE

(2) THRERRAFTERN T (T ML, SR FT BB E e e kA

F

HJ5, ZHE"0-1. 38 >>P.305", Pugis:

u(ll
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6-7-3. MBCCRITED

FJ CAFT B 25 Bl 3 T N

(%]

o HEMSORAFIITENEMERZ Y 100 4>, Ftit 800MB, M F-HHT ENEE  FAamIER: .

o UIWTHIRE, RHMIERORATHORARE

o [BEITEIHURIE SR TEVER] b MR, TEIRAE[EGLRIFATEN D fE . AW ER, §2H"8-12. B3IFRITE
s >>P.213",

(1) MSEE R EG LR T EI R A -
(%]
o IEREHT IR I BT BN -

(2) BB TR R BT BN, 4% N 3TN 464 TER
ITEDSERE, KEHARES SR FE T AT A L, A P
(%]
o IEBURIATHRTRSIN, BIEEL THTEMZH], (ORI RS TR, TTEITFAGITER. W RHAE N ITE AL

. HF @ S TEILH.

o EENEERLASCIERET, W BT, TSR,
(GIRIZATIN, TEN IR AT AR i AT A K . A ATIOR B, 520086, BEIGENTTENZ)
£ >>P210",

o ERRGRAOEREIN, FTENLERS R T A K. RN S S, SIEM0-1. S >>P305", Hudsk
MR AR LR, (A AT EMRAE
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6-8. MEAREHFT

(1) ARFETEMRIE S, R ST
(%]
o ITEIEIMh SR, 152l
o T hiufibihsRnt, T EEERKER.
o T ARG LI R, IR ERE R R
(%]
o HITUMERARER, RULACHE T ML E 20T B AR (TR .

T il

X0114
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6-9. ERIH=

==3

JE

T SR FH I BT o

TEZED
i R AT T PR L ] BT A
HAE

EIGIE S €2 NI G (BN 44 &

[EE]

THER] FE B RPREE T AL EDRIRS o SN, 5 (i 2.

(%]

SERATENT, WREH T Uk e .

T PRSI T BRI B AR ) 2 R

BRI 5 5 PT RERNAE BT BT L.

ISRAE A BB G IR R LR B B L BEEATEN i, DRI RES RSt

URSR A I BEEAUR it S84 T EDAOST B AN (3 o S8 TENROFT BN, MR SRt
BRI, TR P AT B Rl AR X R e R TS Bk 5 15
IRIRPACHEAE E RS I T Al b SR BUC BRI R . EFERTeHKIEbE

TH SR 5E R 2R HIARHE
TR RAIREEANN (B SOPRAE, S IE RIS AT BRI AR AN I 57 5 SRR E R AR A R T # AT

(%]

HRAEAEF BRRENAIBRERSR, SR AN, IR s REAR AR OARAERE o 375 95 S S B AR EE R S8 e SRR X [
Bk

WRAEFTEIN T, AR SesE, BRI P AR IR .

JEHFERIATAL B (M A S e £

FAFLENIS, TERAATH SR E AR AR B ) o

HIERAAT T ARERTHC SRR IE TR, IR ZE VLRI SR TR B LA (RIS A A 1R

ol i INf i)
LN 180°C (356°F) 35 %
HEA FIRE 160°C (320°F) 3 %) 30 fb~5 4

TR T AP ReAR e, DRI R iR A 3L
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T I A T RE R 22

(1) Rk, T Al AR BS R E BT B _E IR T E R
(%]
o RTUMERERAMNIAME, ESH"6-0. ERhE >>P.146",
o ISR INAEREME IR,
o WRUERCM SR EEAEARIEN, WA SRR BCRII, SRR R, WA SEBOGERCRA . EHRYEH

BIX A EH .

0)D)

TAEZED ,
o]

fﬁ%@a w" HER

iz

\/
JiEEMS

Ti
X0115
BRI
(1) SRR T 1.
(5%]
o NTUERERAMIIME, 1ESIR"6-9. Etilisk >>P 146",
o GRS, VT RO DL SR B AR,
o IHSHRERA IR A R B
Ti AR
’ ,
T 1]
[ | | |
out in
X0116
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NTHRTERE /| K

AR

A il e PR A, AT RE B DIWTRIR, 1ESERE 5 0 Bh i JRYR T .

AR

KRR, THESAERAETIR. WRIMETIR, MATse S8,
THZ PV A . W RIRMS B i Bl 2, W PTRES RS A R . BENIRIG WIHE 2084, ML R F/K .
HYMRR

TEZVRT A R TV TR, RS, BT RE S EURYS . MXet.

ik, EREGRHRIE B At 5 . SRORE, THVRIL. PUAGEER PRIRSERR. BIRTRES R 4. HENIRIEA
BB, NSRRI K.

THICEAE ) L E SR AN I o

PRORIAEI, MRS B BB FESE,  DAG RIS SR P B S -

B ATRET AR 2 o

J4h, EZ B, S RESEUE . iXet.

THICEAE) LR AR .

A, G ARAN, B AAAR R 6T R AR A 3 B S, A A w]
N

T U B p PR A, R R WAL P IRRAE, W) e R BOR i .

e & oop

CINEZEHM

HZ TR 50 AT RS EAN L D™ .

THIRERAN LRI A A A2 18] HAS 20 BCE it . 75 0 AT RE SRR S48 o I
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7-1. EHWPITEIR
711, FEHmMBS

ﬁf@ﬁ*ﬁ@ﬁﬁ@?ﬁ%ﬁfrﬁﬁlﬂi S,

(]

. R, WIS, KT E KON, RIS, R AT S,
o FTENFREFT ENSE TS R EEE AT, 1M ERas . IR B S BT ENHLH B,

(5%]

o TEAE AR S ey 2R 480, TR T RE VA IEFE RN .

o N T ARSTETHLCL S R T BN B, I ARS8 Fp 7 R R/ D By AR . 1 T

% §i%
HEAR &6

]

(1) AFTERHL PR BRI s 6
[EE]
o IMERTTREFMESEGNE. EHEWEH.

v
A T

W12 W34
J
X0047
) fHFEEE.
[H3%E]
o {TJFEATEZfRL @O, S, ATRESIA.
o EMETETIHAE, JEES TR T .
i
B
! !
ﬂ/&
T O i
/
. — =
X0042
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(3) FRAEMSRARTURAR T, MSBEH I AR A SRR

=]
o MM (BORAERMMNE) KERINEESGIIRIME. Hoh, EHEES.

T sEA%

PASENIRNIT)
R A

L f
T
X0119
(4) BB PR SR
(S, TR BIZATIESE 100 U0 BEECIfAINE,
[4E]
o BERANRIRS FRR
[SREEMiE 2
X0048
(5)  MPFERECH AR
[%%]
o KIBRTEBRIIANLE. FNATRE BRI, MR,
o BENUAEINAS . WRTHT, REGFAKETE, IAThE SR,
/EE% X0143
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(6) “Krprihsas kg
T I SRS TH B 5 1 e s
Kb BRI L, FITFRREIN 228, DB B e S,
[#%3E]
o HESNGIITEA Y R ERER, EHTRE.
X0049
(7) KSR e R IEA .
(CE=9 |
o ISR EII@)FN. HIATRERIGT
X0041

(8) KM, K@ ZEFHTEINL L.
(%]
o HZIFHERENZORAE . WAHENERIG, ATRERATTEIRIRA RN, WA SE)E, 1R B LR
BHo R SRNEETE R ARG, EIRREEAYILEE.
o RGN, WA MERMSELE, DETIFES.
WARAAERRA, WAREIEM S S48

X0283

[%7E]
o IHKINESHUE B S IRFTH .
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(9) 728 LTI o SR PRSP .

MEME 55 Uso before
A Verwenden vor ilise avan
so antes de so prima
09. 2015

GTX Serles XXX

/
S FH PR 4K

X0144
7-1-2. FESHEPR. SR, HESEEE DA IR
b Em EENME R, EHTEH.
HEAPAT, FIRES FEETEVHAAI PR S5 Y TED . ANWESR 5 | i i T R4
0L
Ta Ve
R RE

| BN

(1) HEGBEMTAEIERE R, 0 T, TEUEH. FRUUS.
(2) ML > TR 2, T @

[E%]
o BRAFIARECE bR A RS S, LIRS B S T .
(%]

o T @I IR, WA AR

(3) HMEE, DIk,
[EZ]
o NTWIIATENSKRMSRART, VH1E 15 e AL,
o I 15 BN, KRMIRTER K, HOEEIEE, BUOERIEEERGEN R, EETG L. AT M ST TRk

Y
/ﬁ{ld:l:o
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(4) FTUTRTERD:, TEEABIEA. B, HE RIS AR R
TR IR T RS R, RIS ] .
[Z%]
o RTIEEUNE WSHLLTU,

R

R

EERBRGHE THEIN | e 0
B Bl

SRl

(.

AR RIEM

g
/ AR
Il S

X0275

(5) JERETR)A, KM .

(6) Y.
[%E]
o IHKIRIESHERIEEEMEFY.
[Z%]
o AT SRR T AT EILIA T .
o HTIHEMSEREA, R TIERBTE R .
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N T HRITEN R / E&F%%ﬁﬁ}
FE A EADRZ I 73 AT P BRIRAR LA HE R s iR AT SRk
KIEAE, HERANH .

1 Bi=lEEEx R

THHERHTH R R ATE TR

TR R BB AL .

R S (S R)  >>P 155"

THHERHTEER T AEDER.

TEH A MBI .
3 ZHR"E VS 158"
TEHEEIR WEHEEIR (EAESEET) >>P.158

tEE RSNl EE S A
ZIFTHF AR (EREEE T >>P160"

RHEHFS R

HEER SRR IELIEER
BRI WS EER T (EAEEET)  >>P162"

py FERAMN.
TR, AR RATH L.

TEHR MR AR SRR AR SR AL .
S SR E VEE 155"
FEFImEER TEHE R (EREERE R)  >>PA155

THIETEYER, MERHTEEE T AE M.

TR IR AL
BHEEIR SIEARIR (EESE T >>P.158"

BRI S R L
ZIEAHF R (SR T >>P.160"

RS R

SRR S T
T VBRI SR T >>P.162"
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FRYETR (ERESER)
(1) FEREDEAR P NS RS P
(2) FHHRE R MRS
(%]
o THARIEEIN, SRR R
o H/PTMBEEEER O, U, SRR L, TR
o JUBWIE OKE) FTREBUAITENSk, FEZEA]
o PR A ORI -
[4E]
o IRIBEIHIOF BT

TEERE R
TELAR

ERA

SR

X0246
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(3) AR R I AR .
[E#]

o /AL T LA K AR (KT AN AR o
(%]

PR TERE S TRENME.

[ | Wb
/£= fl\ b R
i i
W

A T

X0276
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(4) AT B S M T 5 M A T RO A AL o

(%]
o /AR I ZLHE N S .
o IEZMERNERHE R DM TIEA.

EEE I

MR T AT 37 A 2 7]

EERIEA VA

ISP A T
X0237
THIIRES
EEELI] HE
AL TEERAL X0238
WA T AT 5 2 1] MRS T LI A 2 [1]

[E%]
o HCUhSBAIAR I SEHIE R R LA IR
(%]

o ROMHSIAIATRERE OISR, (ERITENR A B R, TR ) M BRI T 1 13 i 28
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FHEIR (EAEGE T
(5) AEIBUAHENEEAH.
(6) FiTIREE T EEMGHUH.
[E%]
o THATEEIR, GERIHTESET
o IEOIMITMBLESEET . G0, HARME LRI b, TR SR
o UK OK%) TTHEBUAITEI, HULEZIHE.
o TEOPKEEYEAR I R R -
(€260
o IRIRBEMI TR

RN

TR

TR

IIENR

X0229

(7) AR T BRI, HH AL 5 IR AR
[E%]
o IBVIMTMELEERE T M0, S0, RARHEEAERIRE, ATRESEGRH .
o REUMSBAME G SRR LA FHE.
o HBUMSSHYSEEEE T REERE, IE2MEME TSR, SATREIARIR, SEAmEE.
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X0230

(9) AEFNEPEAR LG T, JHEZRIHEH IR .
[FE#]
o EEIMBTRR NSRS T LA I .
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BHEHFREE (EREE T

(1) AR T SR R AR AL .
(%]
o IEVIMTMBLESE T K0, S0, RAGHPEERR L, ATRESBURH.
o IHAEUM I EETIEIARI R T T S . RS A B e SR A S AU TR
o WPl ERSUSE R T KR L, IEMENBTERER . BTSN, RN N, SR
(2) Mgt T RAEEEIEARE R B FERR.
[E%]
o HFRERIRANA TSR, TEZEDRTTRENIEREE T, WRAE AT, WA RSB D5 %E.

( N\

R T N Yt
{H{H% *%Hﬁ?ﬁl”ﬁ /H(D%T

AR H

X0244

(3) MEAEBEM YRR T, JHEZJRiEHE iR .

(%]
o HOMSEHIAROMSENEEE T LA ITHEH .
(%]

o HFRERIEARTREFRBNEUOR, (HAENAER .
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EHERES
BT EHE
SREXL]
Tt
HES G IRIE ISR AL HES T MEAG e B r X0239
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HEMKEE (EREE T

(1) AL T T A Ot A AT R i i A LA o

[HE%]

o [HANGIEHE T HEAREEIES. WRAEAEMS, TRESBTHEL TR, AnisE,
o BRI SRR AL . 7RI RE SEGREAR LS .

o IHEZIMITMBLEEE T K0, S0, RARHPEERIR L, ATRESBGRH .

o IEFIESAMATBRAESRATRIBE . AR RIS A B RE T S . RGOSR A B G SR A T

o NBLMSRBRRENTEE TRHERE, 2R TSERBIIR . AT BRI e
o IEVIRAEMGRTHAL, BIWBINE, FTRESEUUENE TIE, STELABISE,

HEET

i

2 ’
1\/\’) Ny

L

eIl /\ eIl

T AN I S

A

(2) CREETERE T EHONTERERR R, PRUETEYA, TR EMET Bk B AR .

[E%]

o EMSRFIAR OISR SRR T LA THE .

o HEMERISHNESET, DL,

TRIBHBAL

o IHIIROMETERKIBIMES MRS, A ACRHETMSE T, BT, HATRE PR RSN
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N T HRITEN R / E&Fuﬁ%%ﬁﬁ}

AR

EER L] EERIE]

X0247
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7-1-3. EHFEEIR

AR TR RS ] DA o BB RS, 1 SE A AR
(%]
SRR, WEASTEINLA RIS . RATENLAHE (FESH . RATR, THRE MG, HSR7-1-5. 1HH
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(4)
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==
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ETHRER B8

_ BN
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o PRFIHMRECE GBI FR R AR SN, IR E SRR TIE .
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o BT @R ORI, WA R
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o NTWIIEATENSRAGMEAR T, TH7E 15 WS RIEL.
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o IEIAEHEM KT ERITIRL

ERETIL
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(6) MEEHHURIERERIN, FEMIRE Pk
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o JTHURELANZE.
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ERETL

e
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Windows 7(32 bit / 64 bit). Windows 8.1(32 bit / 64 bit). Windows 10(32 bit /

¥ OS 64 bit), macOS 10.13 High Sierra. macOS 10.14 Mojave . macOS 10.15
Catalina

B USB2.0. LAN(10 BASE-T. 100 BASE-TX). USB [Nfi#E (B = N2 GB~
32 GB LI'N, lid FAT32 # b i)™ i, A ashe il s s 2 2 D Rer ™ i)

e a1 A/NF2GHz 1) CPU

RARIZ AT L

AT 4 GB 1) RAM
BRI AT XGA(1024x768)
N . CorelDRAW X7 / X8. Adobe Photoshop CS6/CC.
4 & = f'iE A \Y =
AT RERRRERIE R AT Adobe lllustrator CS6 / CC. Adobe Photoshop Elements 14 /15
"': macOS 10.14 Mojave if, i Apple B & IISLFIFEFATENRS, ATREAASITUINATENLE K. $TEA I, i 45A
Adobe lllustrator CC. Adobe Photoshop CC &% Adobe Photoshop Elements.
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VHFEM 4w No. M 4w No.
SRR 350 ml | GCX-4K35-1 R RST R X SB6992
500 ml | GCX-4K50-1 (16" x 21" / 406 X 533mm)
700 ml | GCX-4K70-1 JEARMGAE 16%21 SB7242
PANGEN 55 350 ml | GCX-4M35-1 KIRF AR X SB6994
500 ml | GCX-4M50-1 (16" x 18" / 406 X 457mm)
700 ml | GCX-4M70-1 JEAR 4R 16%18 SB6995
(i SR A% 350 ml | GCX-4C35-1 RN X SBE9YS
500 ml | GCX-4C50-1 (14" x 16" / 356 X 406mm)
700 ml | GCX-4C70-1 JEAREAR 14%16 SB6667
HtayhaRLs 350 ml | GCX-4Y35-1 H/DEER X SB6998
500 ml | GCX-4Y50-1 (10" x 12" / 254 x 305mm)
700 ml | GCX-4Y70-1 JEARME4E 10%12 SB6999
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KR e 44 & ([ SB5495
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